Microsoft Outlook v1.2

Microsoft Exchange/Outlook is the server/client based email package used by the Bow
School District to handle internal and global email and scheduling. The server portion of
the program resides in the Domain BowNET and physically resides in the Media
Management Office at Bow High School. All incoming and outgoing e-mail for
BowNET users resides on that server until accessed by a client.

Outlook email clients can be any of the following:

Outlook Client: (Windows or Macintosh) This is the preferred choice if you have
exclusive access to a single-user computer (Windows 9x or Macintosh OS9) or shared
access to a multi- user computer (Macintosh OSX, Windows 2000, or Windows XP). If
you don’'t have the version of Outlook listed below already installed on your classroom
computer, you should contact your building’s Technology Assistant ASAP.

Current (recommended) Versions:
Windows Users: Outlook 2003
Mac OSX Users. Entourage 2004

IMAP Client: (multi-platform) IMAP is an Internet standard for email clients. Thus
IMAP clients are available for every computer type that | can think of, and are available
for awide variety of hardware capabilities.

Important! While anIMAP client will send and receive our server’s email and run well
on any computer, it doesn't support all of the capabilities we see in the Outlook client.
Possible IMAP clients include: OSX Mail, Eudora, Netscape Mail, Outlook Express, etc..

HTML Client: (multi-platform) If you have access to the Internet and any "frames-
capable" browser (i.e. Netscape 3.0 and higher, Internet Explorer 3.0 and higher) you can
access your Outlook mailbox viathe World Wide Web. One of the advantages to this
method is that there is no need to setup software on the computer you're using.
Important! Whilethe HTML client will supports 90% of Outlook’s capabilities, it
doesn't support al of the capabilities we see in the Outlook client.



Outlook Client:
Profiles:;

Before you can use the Outlook client, you must setup a profile to send/receive your
email. Thisis done by "right" clicking on the "Inbox" icon and selecting properties. From

the properties tab,
you select "show
profiles’ and then

Yau can choose the type of server your new e-mail accaunt will work with,

E-mail Accounts E

Server Type

select "add profile’.

For most users, the
only service you'll
require is '"Micr osoft
Exchange Server".
Y ou should not
select "Internet

Mail" asit can do
bad things to your
school email

account.

&+ Microsoft Exchange Server:

Connect ko an Exchange server to read e-mail, access public Folders, and share
documents,

" pOP3
Connect ko a POP3 e-mail server to download vour e-mail.
" IMAP

C%ﬂect to an IMAP e-mail server to download e-mail and synchranize mailbos:
folders.

" HTTP

Connect ko an HTTP e-mail server such as Hotmail to download e-mail and
synchronize mailbox Folders.

" Additional Server Types
Connect to another wotkgroup or 3rd-parky mail server.

< Back I Mext = I

Cancel |

On the next screen, fill in the "Mailbox" field with your username (i.e. jblow) and fill in

the "Microsoft Exchange
Server” field with
"Odyssey" or useit's full
Internet address
"mail.bownet.org" if
you're accessing your
email from outside the
building. With Outlook
2003, you have the option
of using “Cached Mode”
and you should do so
especialy if youreusing a
laptop. This option will be
grayed out if you are using
thin-client and not
available for versions of
Outlook prior to 2003.

E-mail Accounts

Exchange Server Settings
‘fou can enter the required information to connect to your Exchange server.

Type the name of your Microsoft Exchange Server computer, For information, see your
swskem administrator,

Microsoft: Exchwe Server: Iodyssey
I~ | Use Cached Exchange Mads

Type the name of the mailbox set up For wou by your administrator. The mailbox name
is usually wour user name.

User Marne: Irbaileﬂ

Check Mame I

More Settings ... |

< Back. INEXTI

Canicel |




Sending Email

To send email, click on the "New Message" icon. Destinations for your email

‘ = should be indicated in the "To:" and "Cc:" fields. Email sent to BowNET users
should be addressed to their usernamei.e. "Joe Blow". Email sent to users

outside of BowNET should be

addressed using their Internet address B . ]
i e Ibl OW@a()l .com. |f addr ng Type Name or Select From List: Show Mames frol - the:

email to multiple recipients within a ! doba s L [
fleld, you should Separate the names I Marne | Business Phone | Office
via semicolon ";" i.e. "Joe Blow; I -
Nancy Blow". If you are unsure of a e !

recipient's name or spelling there of, &]Administration

you can access BowNET's global e

address book by clicking on the "To:" Allysan Morse

Alma velasguez
Amanda DiLeo
Armanda Hartung

Groups are indicated by the "two- Amarida Winch -
faced" icon. To seethe members of N —'|_I

any particular group, double click Hesage Recpents
on the group's name. [ re> |1

o> | I
It is proper "Netiquette” to include a Bee > | |
subject in the "subject” field. Filling
out the "bOdy" of the email is very Advanced vl Ok | Cancel |
similar to word-processing in Word 4
and shares many of the same tools. Windows users by default, actually use word to create
their email (WordMail). When finished creating, you can spell check by selecting it from
the "Tools" menu. Y ou send the email by clicking on the "Send Mail" icon.

or "Cc:" buttons.

E-mail Properties:
Y ou can use the "Options' button on the toolbar or select "properties’

Opkions. .. from the file
Message Options EE
= menutosat
. . Message setkings Security
each message's priority and
. . p y @ Importance: [y Il Encryptmessage contents and attachiments
recel pt Optl ons. Sensitivity: INormaI vl = & digital signatire beettamiig message
oting and Tracking options
@ ™ Use voting buttons: | j

™ Tell me when this message has been delivered

™ Tell me when this message has been read

Delivery options

@ ™ Have replies sent to: I Select Mames. .. |
¥ Save senk message ko ISent Ikermns Erowse. .. |

™ Do not deliver befare: I

Le Lo

™ Expires after: I

Categories. . I I

Close




Attachments:

Y ou may also opt to use Outlook to send files (Word Documents, Excel Spreadsheets,

etc.) to email recipients. To do this, compose and address your letter as usual, but then

select "file" from the "Insert” menu. You'll get your
standard file requester, which you'll use to find the
desired fileffiles. Upon pressing the "Okay" buton, you
should see your attached file represented in the body of
your letter as an icon. Press "send” to send. Alternately,
you may email afileto someone, by “right” clicking on
thefile'sicon (if the file is unopened) and selecting
“Mail Recipient” from the “Send To” sub-menu. You
could also elect to send an “opened” file by going to the
application’s “file” menu and selecting “Mail Recipient”
from the “Send To” sub-menu. (not availablein all
applications).

Receiving Email:

= | T

.ﬂm sk a
Hew
Print
Quaick Yiew

Cut
Copy

Create Shaortcut
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Facudty FCC Jarsary
Computer Cl...  Agenda doc
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23 3% Floppy [A)
g Desktop s Shortcut
&4 Mal Recipient
(£ My Briefcase

Emall you receive can be read by double clicking on the icon, which represents the
message. A "read" message can be deleted, stored, replied to, "reply to all"ed (reply sent

to al receivers of the originating email), or forwarded.

If storing and sorting email, you may wish to utilize "sub folders® in Outlook. First of all,
make sure that you can see folders by going to the "View" menus and verifying that
"Folders" is selected. Folders can be added by selecting "New Folder” from the "File"
menu. Drag items from your "Inbox" to the folder or sub-folder of your choosing.

Public Folders:

If you've used newsgroups on the Internet, then you already understand public folders. If
not, think of it as public email, or a bulletin board that everyone can post to. To create a
new "discussion folder”, click on "Public Folders' (folder view) and select "all public
folders'. Once you've done this, you can go to the "file" menu and select "New
Discussion Folder". To post to the folder, select it and choose "New post in this folder"

from the "Compose" menu.



HTML Client:

If you have access to the Internet and any frames capable browser (i.e. Netscape 3.0 and
higher, Internet Explorer 3.0 and higher) you can access your Outlook mailbox via the
World Wide Web. One of the advantages to this method is that there is no need to setup
software on the computer you're using. To do so, start your browser and go to
http://mail.bownet.org/exchange

1) username=jblow

2) password="?

3) domain=bownet

4) Hit Okay and read email

If your browser only provides a 2 line authenticator, username=bownet\jblow (please
note the"\" isnot a"/" which won't work)
The Outlook Server will thengenerate a web page, which looks and acts like your Inbox.

<3 Microzoft Outlook ‘Web Access - Microzoft Internet Explorer
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Important! When finished accessing Outlook via the World Wide Web, you should click
on the "Log Off" link and then exit the browser.



Calendar:

In addition to it’s email abilities, Outlook also functions as a Personal
Information Manager (PIM). AsaPIM, it includes a Calendar, a
Contact Manager, a Task Scheduler, and more. To switch into
Calendar mode, press the Calendar button on the vertical toolbar.

When in the calendar, you can switch between, Day, Work Week, Week, and Month
views by clicking on the appropriate tool.

| |IE| Day [5]Wwork week [7]week [31]Manth |

To add a new appointment, click on the “New Appointment” tool or press the “new”
=7 hotkey (does anyone remember that from previous lessons?). In the resulting
“ = | window, you canenter the “ Subject” of your meeting, the “Location” of your
meeting, the “Start” and “End” times of your meeting, “notes’ for the
meeting, and set a“Reminder” for the meeting. Press the “Recurrence” button to setup a

reoccurring meeting (i.e. the first Tuesday of every month, every Wednesday and Friday,
efc...).

il Untitled - Appointment [_ (O]

“ File Edit Miew Insert Format Tools Actions Help
“ & save and Close | & | % Recurrence. .. | ¢ Irwite Attendess. . | g | * - ¥ - -@

Appointrment ] Attendee Availability ] Cnline I

44 This appointment occurs in the past,

Subject: ||
Location: I j [T This is an online meeting
Startbime: Mo 10/26/98 =] [5:00 Am | I alday event

Endtime:  |Mon1ojzerss | [sEmoam 7|

;& [T Reminder: |15 minutes jﬁl Show time as: IBusy j

-

=
Categaries. .. | I Private [




Y ou can also invite other BowNet users with email accounts to attend your meeting. If

you chose to do this, each
“invitee” will receive an
email, which contains the
details of the meeting (as
your entered in your
appointment) and give them
a chance to either accept the
meeting or declineit. Should
they accept, the details of the
meeting will be
automatically entered into
their calendar and you'll be
notified of their acceptance.
Should they decline, you'll
be notified of their absence.

Contacts:
=

+ N

Contacts

Select Attendees and Resources E
Shove Mames fran the: IGIDbaI Address List j
Type Mame or Select from List;
MR || Feoicds | =l
Administration
Adrinigtrator ;I
Aliceon Ledous
Allyzon Worthington Optional -» | ;I
Amanda Hartung
Ay Blau LI
Andrea Albert
— [ e | L
n Rrannnck hd
LT _'IJ =
Mew. .. | Froperties | Fird... | Send Options. .. |
ak. | Cahicel | Help |

information is searchable (asis any of the information in Outlook).

To add a group (distribution
list), switch to Contacts and
from the “File” menu select,
“\new\distribution list”
Name the group, and press
the “select members’ button
to add addresses to your
list. Members of a
"distribution list" can
include users and lists from
either the global list or your
own Contacts Press "okay"
when finished. To send
email to thislist in the
future, you'd smply press

EB Untitled - Contact

File Edit Wew Insert Format Tools Actions Help

To switch to contacts, click the “ Contact” tool on the vertical toolbar.
While in *“Contact” view, you can add a new contact, by clicking on the
“New Contact” tool or press the “new” hotkey. Enter the appropriate
information into the appropriate box and you’ ve created your contact.
Since thisinformation is al stored as a database, al of the contact
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Job title: I Home: ll I—
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“To” and switch to “Contacts’ instead of the default “Globa” list.




